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UNITED STATES PATENT AND TRADEMARK OFFICE 
Commissioner of Patents 
Washington, D.C. 20231 
 
April 2003 
 
Dear User: 
 
Thank you for using the Electronic Filing System (EFS) and its submission tool, ePAVE 
5.1, to file your patent application electronically. 
 
The USPTO initiated the development of EFS to provide a means for applicants or their 
representatives to submit patent applications and related documents to the USPTO using 
the Internet. The use of the Electronic Filing System supports the USPTO strategic goal 
to integrate patent business practices with information technology to bring about effective 
use of electronic government as part of conducting patent business. 
 
This user manual provides detailed instructions for using the ePAVE submission 
program, and also provides guidance including the system requirements, business context 
of use, and support available for the product. ePAVE is the software application that you 
use to bundle and transmit your documents to the USPTO. 
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PART 1: A QUICK GUIDE TO EPAVE 5.1 
 

�� Step 1 – Obtain ePAVE 5.1 software.  The software can be downloaded from 
www.uspto.gov or provided on CD from the Patent Electronic Business Center by 
calling toll-free 1-866-217-9197.  The ePAVE software has a low level Public 
Key Infrastructure (PKI) certificate built in.  This certificate may be used to file 
new utility and provisional applications.  To file subsequent submissions, obtain a 
customer number and high level PKI digital certificate from the USPTO.   

 
Full details are listed at the Electronic Business Center (EBC) site within the main 
web site of the USPTO at: www.uspto.gov/ebc. 

 
�� Step 2 - Install ePAVE 5.1. 
 

Detailed installation instructions are listed in the overview, in Part 2 of this 
manual. 

 
�� Step 3 – Launch ePAVE 5.1. 

 
Launch ePAVE by double-clicking the ePAVE icon from their desktop or by 

selecting ePAVE from the Start menu under Programs.   
 

�� Step 4 – Begin to use ePAVE. 
 

Immediately after launching ePAVE, users will see the ePAVE splash screen.  
Click on Next at the bottom of the screen to proceed. 
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ePAVE splash screen 

 
�� Step 5 – Ensure that the most current version of ePAVE is running. 
 

A dialogue box will appear, asking: “Would you like to verify if you are running 
the most current version of ePAVE software?” 

 

 
Version Verification dialogue box 

Select Yes to verify now.  Select No to verify later.   
 

�� Step 6 – Begin creating a submission. 
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After verifying the version, the Submission Action screen is displayed.  Users 
have the option of creating a new submission or opening a submission that has 
been started, but not completed.  (A submission that has been started but not 
completed is listed as a Submission under Construction.) 

 

 
Submission Action screen 

 
 

 
�� Step 7 – Choose one of the six submission types. 

 
The drop-down menu of submission types is displayed in the Submission action screen.  
The list displays an alphabetic list of the six submission types that can be filed in ePAVE.  
Users must choose from the following six submission types: bio-sequence listing, 
information disclosure statement, new utility, patent assignment, pre-grant publication, 
and provisional application.   
 

NOTE: The new utility is the default submission type.   

 
�� Step 8 – Complete data entry and create files appropriately for each submission 

type. 
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Each submission type has its own set of instructions that are available as separate 
documents or as one large manual.  In order to fully understand the intricacies of 
each submission type, users are encouraged to review the manuals before using 
ePAVE.  The manuals are available for download and are listed at the Electronic 
Business Center (EBC) site within the main web site of the USPTO at: 
www.uspto.gov/ebc. 
 

�� Step 9 – Submit to USPTO and obtain acknowledgement receipt. 
 

Using either the built-in low level PKI certificate or the USPTO provided high-
level PKI certificate, a secure encrypted session is established with the USPTO 
server.  When the completed submission is received by USPTO an 
acknowledgement receipt containing the application number, confirmation 
number, time and date of receipt, and additional information is returned.  This 
acknowledgement receipt will serve as proof positive that what was submitted 
was what USPTO received.   
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PART 2: AN OVERVIEW OF EPAVE 5.1 
 

SECTION 1: Introduction 
The following lists information about system requirements and limitations, and provides 
detailed installation instructions for installing and using the Electronic Filing System 
(EFS) and its submission tool, ePAVE 5.1, to file patent applications electronically. 

SECTION 2: System Requirements 
 
Processor:  266 MHz or higher Pentium Processor 266 MHz or higher (or similar AMD 
Processor) 
 
Memory: 128 MB RAM.  
 
Screen Display: 1024 x 768 or higher 
 
Browser: Microsoft Internet Explorer 5.0 Service Pack 3 or Microsoft Internet Explorer 
5.5 Service Pack 2 with msxml upgraded to msxml 3.0 Service Pack 2. For more 
information on the msxml upgrade see: 
http://msdn.microsoft.com/downloads/default.asp?url=/downloads/sample.asp?url=/msdn
-files/027/001/772/msdncompositedoc.xml 
 
Tiff Viewer Plug-In: AlternaTIFF v1.3.5 or higher for IE5.0, or AlternaTIFF v1.4 or 
higher for IE5.5 and higher. 
 
Free Hard Disk Space: 25 Megabytes is required for the ePAVE application alone. 
  
Modem:  Internet connection at 56 Kbps or faster  
 
Operating System: Microsoft Windows 98SE, Windows ME, Windows2000 with 
Service Pack 2 or later, Windows NT 4.0 with Service Pack 6 or later or Windows XP 
with Service Pack 1 
 
Applications: Microsoft Word 97, Word 2000, or Word XP including Office Assistant 
 
Graphics Package for TIFF image formatting 
 
Printer Driver (s) must be up to date 
 
Scanner: Any scanner capable of producing black and white TIFF images at 300 dpi 
with CCITT Group 4 compression 
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SECTION 3: Submission Restrictions 
 
Any patent applications submitted to the USPTO through EFS will include one or more 
electronic files.  The following limitations apply to the files that can be submitted in a 
single submission package. 
 
Applications submitted electronically over the Internet: The total submission size 
must be 100 MB or less.  If the total submission size exceeds 100 MB, the submission 
should be copied to a CD-ROM or CD-R and that CD delivered to USPTO.   
 
Any electronic submission is subject to the following limitations:  
 
A new utility or provisional submission may include no more than 5 assignment 
coversheets.   
 
An information disclosure statement may cite at most 50 U.S. patents and 50 U.S. 
published application citations. 
 
A subsequently filed assignment submission may include a maximum of 15 cover sheets.  
Each cover sheet must reference at least one tiff image.   
 
Images must be included as tiff image files in the following format:  Black and white, 
300 dpi, CCITT Group 4 compression or uncompressed, maximum size of 8 ½ by 11 
inches.      
 

SECTION 4: Detailed Installation Instructions 
 
Obtaining ePAVE: CD-ROMs or the USPTO Web Site 

Users can download ePAVE 5.1 from the Electronic Business Center (EBC) site within 
the main web site of the USPTO at: www.uspto.gov/ebc.  The program is also provided 
on a CD-ROM supplied by the USPTO.  Contact the Patent Electronic Business Center 
toll-free at 1-866-217-9197 to obtain a CD.     
 
Installing from a CD-ROM:   

When a CD-ROM is used to install ePAVE, the installation program will automatically 
launch when the Autorun feature is enabled on the user’s computer.   
 
If the installation program does not automatically launch, locate the installation file 
setup.exe on the CD-ROM and double-click on the setup file.   
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Installing from the download: 

If ePAVE is downloaded from the USPTO website, the user should locate the installation 
file, setup.exe on the user’s computer and install the file by double-clicking on the setup 
file.    
 
Running ePAVE Installation from the Start menu 

Using either a CD-ROM or the USPTO web site, users can run the ePAVE installation by 
completing the following steps. 
 

�� Select Run from Start menu. 
 

 
Run screen 

�� Use the Browse button to locate the folder where the setup program “setup.exe” 
was saved to the user’s computer or the drive and folder where it is located on the 
CD-ROM CD).  Or, users can type the full path and file name instead of using the 
browse button. 

 

 
Run file selection 

 
 

�� Highlight the file name setup.exe and select OK. 
 

�� The ePAVE Installshield launches and guides the user through the installation.  
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�� It is recommended that users install the default configuration.  To do so, the Next 
button must be clicked for all choices after choosing Yes to the license agreement.  

 
 
 

Installing New Versions of ePAVE 
 
If an earlier version of ePAVE is present it should be uninstalled prior to installing 
ePAVE 5.1.   
 

 
ePAVE Installation screen 

�� Choose the Remove radio button and select the Next option.  If the user chooses 
to install all the components of ePAVE, all default settings must be left in place. 

 
Users can also uninstall ePAVE by completing the following steps. 
 

�� Select Settings from the Start menu. 
 

�� Select Control Panel from the Settings drop-down submenu. 
 

�� Double-click the Add/Remove Programs icon within the Control Panel submenu. 
 

�� Highlight ePAVE from the list of programs that appears in the lower half of the 
Add/Remove Programs window. 

 
�� Select the Add/Remove button. 
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When an application is about to be uninstalled, a warning about removing shared files 
may appear. The message “Are you sure you want to remove the shared file?” will 
appear.  If this warning appears, select either No or No to All to ensure that other 
applications continue to function properly.  
 

NOTE: If users remove files that are shared by other programs during 
uninstallation, their system may not function properly.  Leaving shared files on the 
computer will not harm the system. 

After completing the uninstallation of the older version of ePAVE, install ePAVE 5.1.   
 

Special Installation Circumstances 
Networked Computers 

ePAVE can be used with Internet connections on a network and with networked 
machines.  In order to install ePAVE or some of its components, users will be required to 
have local administrator privileges.  If users are unsure if they have these privileges, it is 
best to contact Information Technology staff.  The installation program will offer a 
prompt during the installation process to indicate that local administrator privileges are 
required for installation. 
 

 
Administrator Privilege dialogue box 

 
Although it is possible to use ePAVE in a network environment, users should carefully 
consider its effect on file management. 
 
In a networked environment, application files created in ePAVE must reside in network 
storage that is mapped to all machines that are working with ePAVE using the same 
naming convention.  All files should be in a dedicated folder for two reasons: to allow 
common access to the files from any PC on the network and to allow EFS to locate, 
attach, and bundle the files within the application during the final assembly of the 
submission into a package. 
 
EFS stores all files from a single application together, based on their pathname.  Thus, 
once the files have been stored, their location should not be changed.   
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Multiple Computers 

The installation of ePAVE is subject to license agreements that set forth the terms to 
allow installation on one or more computers.   
In order for ePAVE to upload an electronic submission properly, a digital certificate file 
must be transferred.  Users may obtain a high level digital certificates in a two-step 
process by requesting reference information from the USPTO and creating the certificates 
with the USPTO’s Direct Security software after receiving access codes.  A low-level 
digital certificate is built in to ePAVE and may be used for new utility and provisional 
submissions only.   
 
There is no need to reinstall USPTO Direct on multiple machines because users may 
transfer their profile and the digital certificate file to a computer that will be used to file 
the patent application submission. 

What is ePAVE?  What is EFS? 
 
EFS is designed around a common submission engine that presents data collection 
screens to the user to collect patent application information and create electronic patent 
application forms in eXtensible Markup Language (XML). The submission engine is a 
desktop software program called EFS electronic Packaging and Validation Engine 
(ePAVE). In addition to providing electronic forms, ePAVE allows the user to attach a 
tagged, structured specification document that includes links to applicable figure image 
files. Other patent application documents, such as a declaration or a power of attorney, 
may attached as scanned single-page tiff image files or included as XML documents. 
 
EFS electronic Packaging and Validation Engine (ePAVE) desktop software enables 
patent applicants and appointed practitioners to conduct real time electronic filing of 
select new utility and provisional patent applications. EFS also allows user to file four 
types of subsequent filings over the Internet.  These subsequent file types are select pre-
grant publication submissions; information disclosure statements for pending 
applications, assignment documents for previously filed applications and patents, and 
submission of amino acid or nucleotide sequence listings required during prosecution of a 
pending biotechnology patent application.  
 
Who may use EFS? 

The USPTO authorizes select individuals to use EFS to file patent applications 
electronically.  These authorized individuals include inventors, attorneys of record or 
otherwise registered, agents of record or otherwise registered, assignees of record of the 
entire interest, and assignees of record of an undivided part interest.  For more 
information see 37 C.F.R. 1.33(b). 
 
Application Types Allowed 

EFS allows submission of six filing types:  new utility and provisional patent 
applications, pre-grant publication submissions, information disclosure statements and 
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biosequence listings for pending patent applications, and assignment recordation 
documents for previously filed patent applications and patents.   
 
To use EFS software to submit pre-grant publication filings, please refer to pre-grant 
publication regulations 37 CFR, Sections 1.211-1.221, for a full description of the 
process and legal requirements. 
 
A biosequence listing in computer readable form (CRF) may be included with a new 
utility or provisional application.  Alternatively, if you have a pending utility patent 
application that requires a nucleotide or amino acid sequence submission, you may file 
the biosequence listing as a separate follow-on filing.  The submission software accepts 
ASCII Sequence Listing files created by a sequence listing authoring tool, PatentIn (as 
well as accommodating ASCII Sequence listing files created by other standard methods 
or editors). Refer to 37 CFR 1.824. The sequence listing shall be submitted in American 
Standard Code for Information Interchange (ASCII) text. No other formats are accepted. 
 
 
For new utility, provisional, and pre-grant publication submissions, the user must first 
create a specification document as an Extensible Mark-up Language (XML) tagged 
electronic document. The user may then use ePAVE submission software to attach and 
send the application specification with any figures to USPTO along with other patent 
application forms and files.  
 
 
Using ePAVE submission software users may: author XML documents such as fee 
transmittal or application data sheet; attach electronic documents and image files in 
specified formats; and validate the completeness of the submission based on patent 
business rules. The ePAVE program automatically bundles, compresses, and digitally 
signs the submission package once the applicant or appointed practitioner enters an 
electronic signature and digital certificate authentication information. Using the digital 
certificate, the software automatically establishes a Secure Socket Layer encrypted 
session with the USPTO server and transmits the package to the USPTO.  An 
acknowledgement receipt is displayed in real time at the filer’s desktop after the 
submission package is received and validated at the USPTO without error. 
 

SECTION 5: Key Steps in the Electronic Filing Process 
 
The following procedure outlines the steps that must be completed in order for you to file 
a patent application electronically via EFS. 
Step 1: Install ePAVE 

Install the ePAVE tool.   
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Step 2: Obtain a PKI digital certificate  

According to 35 U.S.C. Section 122 USPTO must maintain patent applications in 
confidence.  In order to comply with this law, the USPTO distributes software that 
supports secure communication among the USPTO, applicants, and practitioners.  
 
As a result, the USPTO has implemented several electronic commerce projects that 
promote secure communications, including instituting rules to protect applicants when 
they file patent applications electronically and providing electronic access to pending 
patent applications to authorized persons via the Patent Application Information Retrieval 
(PAIR) system.  USPTO has implemented public key infrastructure technology to 
provide the security of these systems.  A PKI digital certificate is necessary to ensure the 
security of the electronic transmission of patent applications and is used to establish a 
Secure Socket Layer connection with the USPTO server for secure transmission of patent 
application information. 
 
When filing a new utility or provisional patent application, users may use the low-level 
digital certificate that is built in to ePAVE.  The low-level digital certificate is compatible 
with the public key infrastructure that is implemented by the USPTO and allows secure 
communications between applicants and the USPTO. Low-level digital certificates may 
only be used to file new utility and provisional submissions. 
 
High-level digital certificates issued by the USPTO require an approval process.  USPTO 
will also provide a version of Entrust Direct security software that is custom-made for the 
USPTO and is used to create the high-level digital certificate.  Entrust Direct is 
compatible with the public key infrastructure that is implemented by the USPTO and 
enables secure communications among individual applicants, practitioners, and the 
USPTO.  
 

Note:  Obtaining a high level PKI certificate is recommended.  It can be used to 
access application information in private PAIR and allows all six filing types to be 
submitted.   

 
To find out how to obtain a PKI digital certificate, please contact the Electronic Business 
Center (EBC) for patents.  
 
Step 3: Format all files  

Any patent application that is submitted to the USPTO via EFS must meet certain 
formatting requirements. 

File Names 
File names are limited to 25 characters and must be alphanumeric.  The hyphen and 
period characters can be used in file names.  The USPTO recommends using the 8.3 file-
naming convention when naming files that will be used with ePAVE.  This convention 
allows for file name to contain up to eight characters for the name of the file itself and 
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three characters for the file extension and requires both components to be separated by a 
period.  Here is an example of a file name that complies with the 8.3 file-naming 
convention: newfile1.doc. 
 
Allowable characters in file and folder names include letters, numbers, hyphens (-), and 
periods (.).  Special characters should not be included in file names, such as ampersands 
(&), commas (,),  number signs (#), quotation marks (“), and spaces ( ).  It is imperative 
that special characters not be used because they will cause errors that may affect the 
transmission of the patent application.   
 
In naming the ePAVE folder that contains the submission files, the folder name must be 
different than the names of any other files or figures that are included in the submission. 
 

Images 
Since images are an integral part of patent applications, they must meet strict 
requirements before being submitted as part of a patent application.  The USPTO has 
established the following requirements for images that apply to any patent application 
that is filed electronically.  
 
All images must be scanned or converted into TIFF images and comply with the 
following format: a resolution of 300x300 dpi, black and white only, compressed with the 
CCITT Group 4 Compression or uncompressed, and a maximum size of 8 ½ by 11 
inches.  These formatting requirements apply to the following types of images: 

Inline graphics (including complex chemical structures, math equations, tables, 
and custom characters) 
Drawings (figures) – It is recommended that one Figure of drawing be included in 
each tiff file. 
Declaration forms (These may also be submitted as XML files if they are created 
in ePAVE.) 
Assignment documents 
Small entity statements 
Power of Attorney forms (These may also be submitted as XML files if they are 
created in ePAVE.) 

 
These requirements for TIFF images will satisfy all of the quality requirements set forth 
in 37 C.F.R. 1.84.  When the USPTO prints patent applications that were submitted 
through EFS onto 8 1/2” x 11” paper, the margins will be as follows: top-1 inch; left-1 
inch; right- ¾ inch; bottom- ¾ inch.  These margins satisfy 37 C.F.R. 1.84(g). 

SECTION 6: Using ePAVE 5.1 
 
Introduction 

The ePAVE submission engine is used to create a patent application (also referred to as a 
package), view and print it, validate it, and send it electronically to the USPTO.  
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Updating EFS Submission Program (ePAVE) 

The USPTO will periodically release new versions of the ePAVE software.  When this 
occurs, users will need to update the ePAVE software. In order to ensure that the most 
current version of ePAVE is running, ePAVE automatically provides the option to check 
the version each time ePAVE is launched.  
 

 
EPAVE Version Verification 

 
Select Yes to automatically launch an Internet connection and connect to the USPTO 
server.   If the installed version on your machine is not the most recent, check the USPTO 
website at http://www.uspto.gov/ebc/efs/index.html to determine if a new version is 
available. 
 
If you receive the following error message after clicking Yes, your version of ePAVE is 
not the most current. Select OK on the Version error screen and go to the EFS website at 
www.uspto.gov to download the latest ePAVE software. You may also obtain updated 
versions of the five EFS User Manuals from this site. 
 
 
 
 
 

 
Select N
checkin
created.
check th
website 
availabl
 
 

Version Error screen 

o on the Version Verification screen to launch ePAVE software without 
g for the most recent version.  After selecting No, a new submission may be 
 After beginning the upload process, the ePAVE software will automatically 
e version.  If the installed version is not the most recent, check the USPTO 
at http://www.uspto.gov/ebc/efs/index.html to determine if a new version is 
e. 
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Disable or Re-enable Version Checking at Startup 

If you want to disable ePAVE’s automatic version checking on startup, you may deselect 
it from the View menu. Click the Enable Version Check (at Start) to toggle it on and off. 
The check mark indicates that version checking at startup is active, and is not shown once 
you disable this feature. 
 

 
Disable or Re-enable Version Checking 

 

NOTE: You cannot disable the version check at upload feature. When ePAVE 
performs this check, it will only inform you whether or not your ePAVE version is 
the most current. 

The ePAVE User Interface 

The ePAVE interface includes the following components—menus, a toolbar, a data entry 
screen and navigation screens.  The menus allow you to perform various functions, 
including opening and closing documents, saving and printing documents, validating 
your submission, and sending it to the USPTO.  The toolbar provides buttons that allow 
you to perform various ePAVE tasks without using the menus.  The screens contain the 
data fields where you enter your submission information that is sent to the USPTO and 
allow you to navigate through your submission according to the actions that you wish to 
perform, or moving from form to form. 
 
The ePAVE Toolbar 

 
The ePAVE toolbar is shown below:   
 

 
ePAVE Toolbar 

 
The following provides a list of the toolbar icons and their names, and also provides a 
description of the function of each icon. 
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 - New Icon.  Use this icon to begin a new EFS submission.   
 

- Open Icon.  Use this icon to open an existing EFS submission file that you 
previously saved.  Locate the existing submission folder in the directory path. 
 

- Save Icon.  Use this icon to save the EFS submission information you have 
authored so far. 
 

- Cut Icon.  Use this icon to remove text from the selected text field. 
 

- Copy Icon.  Use this icon to copy the selected text. 
 

- Paste Icon.  Use this icon to paste text to the selected text field. 
 

- Print Icon.  Use this icon to print the information on the active screen. 
 

-Help Icon.  Use this icon to access help information for using ePAVE. 
 

-Toggle Legend Icon.  Use this icon to display or hide the tree legend.   
 
Navigating Through ePAVE 

Users can navigate through ePAVE in a number of ways.   
 

�� A user may navigate by using a mouse and interacting with the graphical screen 
display provided and entering text from the keyboard or a user may navigate 
through the screens using keystrokes only.   

 
�� A user may move from screen to screen using the Back and Next buttons 

provided in the ePAVE wizard.   
 

�� A user may navigate through the screens by selecting a particular action from the 
Actions tree.   

 
�� A user may navigate to particular screens using the Forms tree.   

 
New users may wish to walk through all the screens in ePAVE and would benefit from 
seeing all the screens.  That user would likely use the ePAVE wizard navigation by using 
the Next and Back buttons to move through the application.   
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Back and Next buttons in the ePAVE wizard 

 
More advanced users may wish to include information on specific screens only and 
would benefit from navigating via the Forms tree.  Selecting a specific screen from the 
forms tree will display that screen and allow data entry into that screen.  
 

 
Forms tree 

Users may navigate by function using the Actions tree to perform a particular function, 
such as attaching or removing a file from the Attach Files to Project screen by selecting 
Attach files to the project from the Actions tree.     

 
Actions tree 

 
Keyboard and Mouse Navigation 

 
Once a screen is displayed, a user can move through the data fields by using the TAB key 
on the keyboard or by clicking in each field with the mouse. Users can also move 
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backwards through the fields by simultaneously pressing the SHIFT and TAB keys on 
the keyboard.  Selections of radio buttons on the screens can be done using a mouse or by 
toggling through the choices using the up and down arrow keys.  Check boxes can be 
checked or unchecked by clicking with the mouse or by using the space bar.  Buttons on 
the screen can be pressed by clicking on them with the mouse or by using the space bar.  
For example, when a user wishes to move to the next screen, the user can select the Next 
button and press the space bar. 
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The ePAVE Trees 

   

The left side of each ePAVE screen includes the Actions tree with the Forms tree 
displayed beneath it.   
 

Actions Tree 
Selecting one of the items in the Action Tree activates a desired action.  The Actions tree 
will indicate which action is being completed by displaying the purple arrow icon  .   
   
Enter common data elements will launch the Add Common Data Elements screen 
where data common to many of the ePAVE-generated forms may be entered.   
 
Attach files to the project will launch the Attach Files to Project screen where files may 
be attached to and removed from the submission.  The contents of the submission may 
also be viewed in the Attach files to the project screen.   
 
Validate the project will launch the Validate the Project screen where the correctness 
and completeness of the submission can be determined.  Error and warning messages 
displayed on this screen will help users ensure that a complete and correct data set is 
being sent to USPTO.   
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Submit to USPTO will launch the Submit to USPTO screen where comments about the 
submission may be entered and where electronic and digital signatures are provided.  The 
Send button on this screen may be selected to begin transmission of the filing to the 
USPTO server.   
 
Obtain Acknowledgement Receipt will launch the Acknowledgement Receipt view and 
allow printing of the acknowledgement receipt returned by USPTO after submission has 
occurred.   
 

Forms Tree 
 
A user can navigate to particular screens in ePAVE using the Forms Tree. 
 
XML forms are created in ePAVE by entering data on one or more screens.  The screens 
associated with each form are listed in the Forms Tree.  Each of the ePAVE screens is 
represented by a symbol and text branches in the Forms Tree.  A user can access the 
different screens by selecting the branch that corresponds to the desired screen.  The 
specific Forms tree and screens that are available is dependent upon the type of 
submission being filed. 
 
Once a screen is displayed, a user can move through the data fields by using the TAB key 
on the keyboard or by clicking in each field with the mouse. Users can also move 
backwards through the fields by simultaneously pressing the SHIFT and TAB keys on 
the keyboard.  Selections of radio buttons can be on the screens can be done using a 
mouse or by toggling through the choices using the up and down arrow keys.  Check 
boxes can be checked or unchecked by clicking with the mouse or by using the space bar.  
Buttons on the screen can be pressed by clicking on them with the mouse or by using the 
space bar.  For example, when a user wishes to move to the next screen, the user can 
select the next button and press the space bar.     
 
The ePAVE data entry screens must collect a minimum amount of information to ensure 
that the electronic patent application filing is complete and valid for examination and 
subsequent publication. All mandatory fields or sections in ePAVE are identified by bold 
type, while optional fields or sections are shown in regular type. 
 
Help button 

 

  The Help button in the lower right corner of each screen will bring up 
screen-specific help to assist a user in filling out patent application documents. 
 
Legend 

 
The meaning of the symbols in the trees can be displayed by viewing the Legend.   

 EFS Submission Manual: ePAVE 24



 

 

 
ePAVE legend 

 
The information entered in the fields on each screen is automatically tagged as XML 
(extensible markup language) output. The screens and fields are described in detail in the 
following sections: Creating a Bio-sequence listing, Creating a Provisional, Creating an 
Information Disclosure Statement, Creating New Utility, Creating a Pre-Grant 
Publication, or Creating an Assignment. 
 
Using the Address Book 

 

 
Address book 

 
To facilitate the reuse of previously keyed data, ePAVE 5.1 offers an Address Book 
feature.  In instances where name and address information must be entered, the user can 

reuse previously keyed information by clicking on the Ab key,  to the right of the 
data fields.  A user can enter a few letters of one of the names and select the Search key.  
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The Address book will search for that name and offer matching or nearly matching names 
in the data field.  A user can highlight the desired name, double-click on it or select the 
Select key, and the name and/or address information for that address book entry will 
automatically be populated into the ePAVE screen.  
 
Highlighting a particular field at the top of the data field and selecting the Sort key can 
sort entries in the address book. 
 
Name and address information can be added to the address book by entering the desired 
data and selecting the Add key.   
 
To delete an entry, highlight the name and address in the data field and select the Delete 
key.    
 
Saving a Submission 

 
A user can save ePAVE submission documents at any time. Saving preserves your patent 
application data so that you can change or print it at a later date. Use one of the following 
procedures to save the electronic files: 
 
Click the Save icon on the toolbar. This immediately saves entered data. 
 
OR 
 
Go to the File menu and select Save. 
 
The submission contents will be saved in the submission folder with a file extension of 
epv.   
 
 
Printing in ePAVE 

 
When application data sheet, fee transmittal, biosequence transmittal, information 
disclosure statement and assignment recordation forms are open, those forms will print 
when you select Preview from the Forms Tree or by selecting the Print icon, or by 
selecting Print from the File menu.  
 
Forms may also be printed by highlighting the form in the Attach Files to Project screen 
and selecting View.  Print the form by right clicking and selecting Print or by using the 
keyboard shortcut Ctrl + P.   
 
Filing Large Submissions Using Compact Discs 
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If a user attempts to file a submission that exceeds the EFS system limit of 100 
Megabytes, ePAVE generates an error message and advises the user to submit the large 
application on a compact disc (CD or CD-R).  Submissions larger than 100MB cannot be 
submitted via the Internet.  If a large biotechnology sequence listing, table, or computer 
program listing is causing the large application size, these items may be submitted with 
the application according to the requirements of 37 C.F.R. 1.52 (e) with the large section 
on CD and the rest in paper.  However, regardless of the cause of the large size of the 
submission, EFS can be used to file the application on CD.  The process requires a 
compact disc recorder, and can only be used for submissions that fit on a single compact 
disc. 

Before Saving to CD 
Before saving the zip files and sending the CD to USPTO, verify that all image files are 
compressed. If the application figure images are not compressed, the images can be 
compressed using various image editors. Use the following procedure to compress 
application figure images: 
 

�� Remove the specification XML document from the attachments in ePAVE. 
 

�� Open one of the images in an image-viewing tool.   
 

�� Specify the following settings for the image:  
File type: TIFF 
Color: Black & White 
Compression: CCITT Group 4 
Resolution: 300x300 dpi 

 
�� Save the image. 

 
�� If the tiff image problem is caused by a declaration, power of attorney, or 

assignment tiff image file, do the following: 
 

�� Open the image in an image-viewing tool.   
 

�� Specify the following settings for the image:  
File type: TIFF 
Color: Black & White 
Compression: CCITT Group 4 
Resolution: 300x300 dpi 

 
�� Save the image. 

  

Saving a Submission on CD 
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If the submission is still larger than 100 MB after compressing image files, use the 
following procedure to submit packages larger that 100MB on CD:  
 

�� Print out the Transmittal Form from the Attach Files to Project screen by selecting 
the file including the suffix pkgdata. 

 
�� Copy the submission folder that contains the entire application from the 

workstation to compact disc-recordable (CD-R) media.  
 

�� Wrap the CD in a hard case within a padded protective mailing envelope, and 
attach a copy of the transmittal form.  Enclose a cover letter explaining that the 
submission contains an application that was too large to be submitted via the 
Internet.  See 37 CFR 1.52 for more information on providing compact discs to 
USPTO.    

 
�� Hand carry or mail the CD-R and a copy of the paper transmittal form and cover 

letter to the USPTO. The submission may also be deposited with the US Postal 
Service under the Express Mail procedures of 37 CFR § 1.10.  

 
�� Keep a copy of the CD and transmittal form for your records.   

 
Once the USPTO receives the CD in the mailroom, the date of receipt is recorded and the 
submission is uploaded to the EFS server, where the files are unzipped.  The application 
files will then be processed as EFS submissions and an acknowledgement receipt will be 
mailed.  
 
If the files contain large tables, sequence listings or computer program listings, the 
USPTO has the option of not printing the large files, but rather burning two CD-Rs of 
such data and treating them under the CD practice of 37 CFR 1.52(e).  If the file is an 
amino acid/ nucleotide sequence listing, then one additional copy of such a sequence 
listing will be created and sent to Scientific and Technology Information Center as the 
Computer Readable Form of the sequence listing.  In any case, one CD is placed in the 
file, and one is put in the CD repository. 
 
USPTO Office of Initial Patent Examination’s Electronic Application Review Office 
processes payment by credit card or deposit account in the same manner as an on-line 
submission.  The files provided on CD are signed, so the patent application data is 
protected during mailing and any storage time at the USPTO.  
 

SECTION 7: Contact Information 
 
Check the User Guide - This manual provides all of the information needed to use the 
ePAVE software. Please check the table of contents to locate information.  
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Check the Online Help - Click Help in the ePAVE application to review information 
about the version of ePAVE that you are using. 
 
Check the EFS web site - The EFS web site provides links to additional EFS support 
resources.  The EFS web site is accessible at www.USPTO.gov/ebc/efs/index.html. 
 
Contact the EBC Customer Service Center - 703-305-3028 or toll free at 1-866-217-9197 
from 6 AM to 12 midnight Monday to Friday.   
 

Contact the USPTO Patent Assistance Center (PAC) - 1-800-PTO-9199, efs@uspto.gov. 
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 INFORMATION DISCLOSURE STATEMENTS 

Information Disclosure Statements: At a Glance 
 
In order to file an information disclosure statement  electronically in ePAVE, users must 
complete certain steps.   
 
Although users may navigate freely throughout ePAVE without following any set order, 
the steps and screens listed below follow the natural progression of ePAVE, as if the user 
were to select the Next button at the bottom of each screen.  
 
STEP 1: Install and Launch ePAVE 
STEP 2: Create a Submission Action and Submission Folder 
STEP 3: Provide Data Within the Information Disclosure Statement Module 
 

Add Common Data Elements Screen 
Information Disclosure Statement Screen  
Fee Calculation Screen  
Method of Payment Screen  
Attach Files to the Project Screen 
Validate the Project Screen 
Submit to the USPTO Screen 
Obtain Acknowledgment Receipt Screen 
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Install and Launch ePAVE 
 
Obtain ePAVE 5.1 by downloading the software from uspto.gov or by calling the patents 
Electronic Business Center toll-free at 1-866-217-9197 and requesting the software on a 
compact disk.   
 
Install ePAVE 5.1.  This will create an icon on the desktop. 
 
Highlight the ePAVE 5.1 icon on the desktop and launch the program by either double-
clicking on the icon or pressing Enter on the keyboard.  This will launch the ePAVE 5.1 
splash screen.    
 

 
ePAVE splash screen 

�� Select the Next button to proceed.  Select the Cancel button to exit ePAVE.  
Select the Help button for information about ePAVE. 

 
Selecting the Next button will launch a dialogue box that allows verification that the most 
current version of ePAVE is running.   

 EFS Submission Manual: ePAVE 31



 

 
Version Verification dialogue box 

�� Select Yes to verify that the most current version of ePAVE is running.  Select No 
to verify later.   

If Yes is selected and the version is the most current, a message to that effect is displayed.   
 

 
Current version message 
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Create a Submission Action and Submission Folder 
Submission Action Screen 

 

 
Submission Action screen 

�� To create a new submission, select the Create New Submission button and choose 
Information Disclosure Statement as the submission type from the drop-down 
menu. 

 
�� Select the Back button to return to the ePAVE splash screen.  Select the Next 

button to proceed to the Submission Folder screen.  Select the Cancel button to 
exit ePAVE.  Select the Help button for information about the screen. 

 EFS Submission Manual: ePAVE 33



 

Submission Folder Screen 

 
Submission Folder screen 

 
If Next was selected, the Submission Folder screen will be displayed. 
 

From the drop-down menu select a location for the new submission folder. ��

��

Enter a submission name 

Enter a name to identify the submission.  This will create a submission folder that 
will store all related documents for the submission.  Enter any alphanumeric name 
without any spaces or special characters.  ePAVE will automatically save files for 
this submission in the submission folder.  

 

Note: Users are required to create a submission folder before working on a submission. 

 
 
The submission folder may include documents formatted in XML (eXtensible Markup 
Language) language, such as the transmittal document, a fee document, and the 
information disclosure statement.  This folder may also contain an error log that includes 
validation errors (if applicable), the acknowledgment receipt (as proof that the USPTO 
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received the submission), and a zip file that contains the entire submission being sent to 
the USPTO. 
 
After the first submission folder is created, the next time a new submission folder is 
created in ePAVE, the directory will default to the directory where the previous 
submission folder is located.  
 

�� Select the Back button to return to the Submission Action screen.  Select the Next 
button to proceed to the Add Common Data Elements screen.  Select the Cancel 
button to exit ePAVE.  Select the Help button for information about the screen.   

 

Submission Action Screen 
 

 
Submission Action Screen:  Open Submission Under Construction 

�� To edit or modify an existing folder select the Open Submission Under 
Construction (Created, not yet submitted) button.   

 
�� Select the Next button to activate the Submission Projects screen. 
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Submission Projects Screen 

 
Submission Projects screen 

Type the folder path and name or select the button labeled  . . .  which stands for 
browse to navigate to the folder to be opened.  When the folder is opened, select 
the file with the extension .epv.   

��

��

 
Select the Back button to return to the Submission Action screen.  Select the Next 
button to proceed to the Add Common Data Elements screen.  Select the Cancel 
button to exit ePAVE.  Select the Help button for information about the screen. 
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Providing Data in the Information Disclosure Statement Content 
Model 

Add Common Data Elements Screen 
 

 
Add Common Data Elements screen 

Enter data that will be used on more than one ePAVE-created form in the data 
entry boxes.   

��

��

��

 
Title of the Invention 

Enter the full title of the patent application.  Include all spaces and punctuation.  
The title may contain a maximum of 500 alphanumeric characters.  REQUIRED. 

First Inventor 

Enter the name of the inventor who is listed first in the declaration of the patent 
application related to this submission.  REQUIRED. 

 
Prefix- Enter any name prefix of the first named inventor.  Choose the desired 

prefix from the drop-down menu or type directly into the data field.  OPTIONAL. 
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First Name - Enter the first or given name of the first named inventor.  
REQUIRED. 

 
Middle Name - Enter any middle name of the first named inventor.  OPTIONAL. 

 
Last Name – Enter the last or family name of the first named inventor.  

REQUIRED. 
 

Suffix – Enter any name suffix of the first named inventor.  OPTIONAL. 
 
All changes to the first inventor name information must be made from the Add Common 
Data Elements screen.   

NOTE:  Each name should contain a maximum of 50 characters.  Characters beyond the 50th 
will be truncated within USPTO internal automated information systems. 

 
Filer 

Enter the name and any registration number of the person filing the patent 
application. 

��

 
Prefix- Enter any name prefix of the filer.  Choose the desired prefix from the 

drop-down menu or type directly into the data field.  OPTIONAL. 
 
First Name - Enter the first or given name of the filer.  REQUIRED. 

 
Middle Name – Enter any middle name of the filer. OPTIONAL. 
 
Last Name - Enter the last or family name of the filer.  REQUIRED. 
 
Suffix – Enter any name suffix of the filer.  OPTIONAL. 
 
Registration number – Enter the USPTO registration number of the filer 
OPTIONAL.   
 

�� Select the Add button to add the filer.  Repeat for each filer.   
 

Select the Add button after entering the filer information.  Enter additional filer 
name information if more than one person is filing the submission. 
 
To edit filer information, select a filer’s name from the list.  The filer’s name will 
be available in the data entry boxes for editing when the name is selected.  Edit the 
information and select the Update button. 
 
To delete a filer, select the filer’s name from the list and select the Delete button. 

 
Add, 

Update,  or 
Delete 

information 
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Examiner 

Enter the name of the examiner assigned or likely to be assigned to the 
corresponding patent application.  OPTIONAL. 

��

��

��

��

��

��

 
Prefix- Enter any name prefix of the examiner.  OPTIONAL. 

 
First Name - Enter the first or given name of the examiner.  REQUIRED if an 

examiner is specified. 
 

Middle Name – Enter any middle name of the examiner.  OPTIONAL. 
 

Last Name - Enter the last or family name of the examiner.  REQUIRED if an 
examiner is specified. 
  

Suffix – Enter any name suffix of the examiner.  OPTIONAL. 
 

Group Art Unit – Enter the group art unit where the Examiner is assigned.  
OPTIONAL. 
Application Number 

Enter the eight-digit application number associated with this submission.  
REQUIRED 

Confirmation Number 

Enter the four-digit confirmation number associated with this submission.  
REQUIRED 

Filing Date 

Enter the filing date of the application associated with this submission.  
REQUIRED   

Attorney Docket Number 

Enter a reference number of up to 25 characters that is used to identify the patent 
application.  This number is not assigned by the USPTO and can be any 
combination of numbers and letters.  OPTIONAL. 

 
Select the Next button to proceed to the Information Disclosure Statement 
screen.  Select the Help button for information about this screen.     
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 Information Disclosure Statement Screen 
 

 
Information Disclosure Statement screen 

 
�� Select either the US Patent Citation button or the US Published Application 

Citation button.  Selecting the US Patent Citation button will disable the US 
Published Application Citation button and vice versa.   

 
U.S. patent citations 

A maximum of 50 U.S. patents may be cited per information disclosure statement 
submission that is filed electronically.     
 

�� Select the US Patent Citation button to cite a U.S. patent.  Enter patent 
information and select the Add button.  

  
Patent/publication number - Enter the patent number or publication number for each 

U.S. patent citation.  Patent numbers must be 7 or 8 characters with the first two and the 
last being alphanumeric, and all others being numeric.  Provide leading zeros for numbers 
with fewer than 7 characters.  REQUIRED if a patent is being cited.   
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Date – Enter the date when the patent was issued.  Or, select the date from the drop-
down menu, which converts into a calendar.  REQUIRED. 
 
Name - Enter the name associated with the patent.  REQUIRED. 
 
Kind – Enter the USPTO kind code for the patent.  OPTIONAL. 
 
Class – Enter the USPTO classification used to classify the patent.  OPTIONAL. 
 
Sub-class - Enter the USPTO classification used to classify the patent.  OPTIONAL. 

 

 
Add, 

Update,  or 
Delete 

information 

Select the Add button after entering a citation.  Enter additional citations if 
desired.   
 
To edit citation information, select a citation from the list.  The citation will 
be available in the data entry boxes for editing when the citation is selected.  
Edit the information and select the Update button.  
 
To delete a citation, select the citation from the list and select the Delete 

button 
 
U.S. published application citations 

�� Select the US Published Application Citation button to cite a published U.S. 
patent application.  Enter the information and select the Add button. 

 
Patent/publication number - Enter the publication number for each published U.S. 
patent application citation.  Publication numbers are 11 digits.  REQUIRED.   
 
Date – Enter the date when the patent application was published.  Select the date from 
the drop-down menu, which converts into a calendar.  REQUIRED. 
 
Name - Enter the name associated with the published patent application.  
REQUIRED. 
 
Kind – Enter the USPTO kind code for the published U.S. patent application.  
OPTIONAL. 
 
Class – Enter the USPTO classification used to classify the published U.S. patent 
application.  OPTIONAL. 
 
Sub-class - Enter the USPTO classification used to classify the published U.S. patent 
application.  OPTIONAL. 
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Add, 
Update,  or 

Delete 
information 

Select the Add button after entering a citation.  Enter additional citations if 
desired.   
 
To edit citation information, select a citation from the list.  The citation will 
be available in the data entry boxes for editing when the citation is selected.  
Edit the information and select the Update button.  
 
To delete a citation, select the citation from the list and select the Delete 

button. 
 
Certification 

To make a certification as required by 37 C.F.R. 1.97 and 1.98, select the 
appropriate button.   

��

��

��

��

 
If no certification is being made, select the No certification button.  

Remarks 

Enter any remarks about the cited references in the remarks data entry box.  These 
remarks should not include a response to a previous USPTO Office action. 

 
Select the Back button to return to the assignment dialogue box.  Select the Next 
button to proceed to a dialogue box where the option of providing fee information 
is made available.  Select the Help button for information about the screen.     

 

 
Fee calculation prompt 

�� Select Yes to include fee information. 
�� Select No if no fee is required. 
�� Select Cancel to remain on the Information Disclosure Statement screen. 

 
See 37 CFR 1.97 and 1.98 for more information about information disclosure statements, 
certifications, and fees.   
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Fee Calculation Screen 
 
If Yes is selected, the Fee Calculation screen is displayed. 
 

 
Fee Calculation screen 

�� The fee associated with filing an information disclosure statement is pre-
populated on the screen.   

�� Select the Back button to return to the information disclosure statement dialogue 
box.  Select the Next button to proceed to the Method of Payment screen.  Select 
the Skip button to skip the creation of a fee sheet.     

 

Note: A fee transmittal form will not be created if the Skip button is selected.   

 
�� Select the Help button for information about the screen.     
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Method of Payment screen 
 

 
Method of Payment screen 

The total fees due for this submission are shown in the Total fees due data box.   
�� Choose the method of payment.  Select either Deposit account or Credit Card.  

Selecting the Deposit Account button will disable the Credit Card button and data 
fields and vice versa. 

Deposit Account 

�� If Deposit Account is selected enter deposit account information in the data fields.    
 

Additional fees – Select this check box to authorize the USPTO to charge additional 
fees, as set forth in 37 C.F.R. 1.16 or 1.17. 
 

Issue fees – Select this check box to authorize the USPTO to charge issue fees that 
are due at the time of mailing of a notice of allowance, as set forth in 37 C.F.R. 1.18. 
 

Assignment fees - Select this check box to authorize the USPTO to charge additional 
assignment fees, as set forth in 37 C.F.R. 1.21(h). 
 

 EFS Submission Manual: ePAVE 44



 

Deposit account number - Enter the USPTO-issued deposit account number.  
REQUIRED. 
 

Deposit Account Access code – Enter the access code associated with the deposit 
account for automated deposit account processing.  OPTIONAL unless automated 
deposit account processing is desired.      
 

Re-enter code – Reenter the access code to ensure that the proper code was initially 
entered.  OPTIONAL unless automated deposit account processing is desired.   
 

Deposit account name – Enter the first and last name of the person or entity 
associated with this USPTO deposit account number.  REQUIRED. 
 

Authorized user name – Enter the first and last name of the user authorized to use 
this USPTO deposit account.  REQUIRED. 
 

Electronic signature mark – Enter the electronic signature mark of the authorized 
user of the USPTO deposit account.  REQUIRED. 
 

Note: This signature is an electronic legal signature.  The individual named MUST add a 
signature. 

 
Date Signed - Enter the date that the electronic signature mark is made or select 

the date from the drop-down menu, which converts into a calendar.  REQUIRED. 
 
Credit Card 

�� If the method of payment selected is credit card, choose the type of credit card 
used by selecting one of the Visa, Master Card, American Express, or Discover 
check boxes.   

 
Credit Card Number - Enter the credit card number.  REQUIRED. 

 
Expiration Date – Enter the expiration date of the credit card or select the date from 

the drop-down menu, which converts into a calendar.  REQUIRED. 
 

Name as appears on the card – Enter the name provided on the credit card.  
REQUIRED. 
 

Billing address postal code – Enter the postal code of the credit card billing address.  
REQUIRED.    
 

�� Select the Back button to return to the Fee Calculation screen.  Select the Next 
button to proceed to a dialogue box where the option of displaying the Attach 
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Files to Project screen is made available.  Select the Help button for information 
about the screen.  

 

 
Attach files to the project dialogue box    

�� Select Yes to proceed to the Attach Files to Project screen. 
�� Select No to proceed to the Validate Project screen. 
�� Select Cancel to remain in the Method of Payment screen. 

 

Attach Files to Project Screen 
If Yes is selected, the Attach Files to Project screen is displayed. 
 

 
Attach Files to Project screen 
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General information 

Data entered in previous screens is captured in forms in XML format.  These forms are 
automatically attached to the submission and appear in the attachments screen.  Each 
XML document will refer to a document type definition file and a stylesheet. 
 

 
Attach Files to Project:  View file details 

 
�� After files are attached, select and highlight any filename in the Contents of 

submission package listing to view the details of that file, as shown in the Selected 
document details field.  The Selected document details field shows the file name 
including the path, file date, file size, and file details for some file types. 

 
�� To remove a file, highlight the file in the Contents of submission package listing 

and select the Remove button. 
 

�� To view a file, highlight the file in the Contents of submission package listing 
and select the View button.   
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Viewing and printing files 

�� Highlight a file from the Contents of submission package listing and select the 
View button.  This will launch a browser where the file is displayed using the 
USPTO stylesheet.   

 
�� Print the file by right clicking in the browser and selecting Print or by using the 

keyboard shortcut Ctrl + P.  
 

�� Files may also be viewed and printed by selecting the Preview option from the 
Forms tree and selecting the Print icon, by selecting the Print option from the 
File menu, or by using the keyboard shortcut Ctrl + P. 

 
�� Preview the transmittal by selecting Print Preview from the File menu. 

 
�� Select the Back button to return to the Method of Payment screen.  Select the 

Next button to proceed to the Validate the Project screen.  Select the Help button 
for information about the screen.     

 

Validate the Project screen 

 
Validate the Project screen 
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The Validate the Project screen validates the submission to identify any errors before the 
submission to the USPTO.  
 

To validate a project verify that an Internet connection is in place.  An Internet 
connection must be in place for validation to occur. 

��

��

��

��

��

��

��

��

 
Validate the submission at any time by selecting the Validate the Project from the 
Actions tree.  

 
View details of any validation errors or warnings by highlighting the error or 
warning in the Validation message listing.  The Details will appear in the Detail 
validation message box.   

 
Select the Print button to print a list of current.  This will launch a dialogue box 
requesting permission to print the errors.  Select Yes to print a listing of all errors 
and warnings and details of the errors.  Select Cancel to return to the Validate the 
Project screen. 

 
Correct the error by following the suggestion listed in the Detail validation 
message field. 

 
Repeat these steps to correct all errors.   

 
Select the Back button to return to the Attach Files to Project dialogue box.  
Select the Next button to proceed to the Submit to USPTO screen. 

 
If errors or warning are encountered upon proceeding, a dialogue box will be 
displayed indicating that errors/warnings have been encountered.   

 
 

 
Validation warning dialogue box 

 
�� An Information Disclosure Statement cannot be submitted until all errors and 

warnings are corrected.  Select No to return to the Validation screen and follow 
the steps to correct all of the error and warning conditions.  
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Submit to USPTO Screen 
 

 
Submit to USPTO screen 

�� Proceed to the Submit to USPTO screen only after fully entering required and 
optional data in the previous screens, validating the submission, and correcting 
any errors.  

Comments 

�� Enter any comments to be included with the application in the Comments data 
entry box. 

 
Required fields and data entry in the Submit fields 

�� Select the two I accept (required) check boxes to indicate that the filers who have 
signed this submission have reviewed it and can attest to its completeness. 

 
�� Select a particular filer from the Signature list.  The filer must enter a mark that 

the filer intends to be an electronic signature in the Signature field.  REQUIRED. 
 

Note: This signature is an electronic legal signature.  The individual named MUST add a 
signature. 
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Signature capacity – Enter the signature capacity of the filer.  Or, select the 
signature capacity from the drop-down menu.  OPTIONAL. 
 

Date – Enter the date that the submission is being signed.  Or, select the date from 
the drop-down menu, which converts into a calendar.  REQUIRED. 
 

�� Select the Update button to update the information.   
 

�� Repeat for each filer.    
 
Entrust security certification 

�� Select the Select security certification button to indicate which Entrust PKI 
certificate will be used to make this submission.  The PKI certificates will 
establish a secure, encrypted session with the USPTO server for making the 
submission.   

 
Security Certification Screen 

 
Security Certification selection screen 

 
�� To make the submission using the USPTO issued high level PKI certificate enter 

the path and name of the Entrust profile in the Entrust profile file data box.   
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�� Browse to the file location using the button labeled …. 
 

 
Entrust Profile File look-up 

�� Select the Entrust profile file and select the Open button or double-click on the 
profile file.  

 
Password - Enter the user created Entrust password. 

 
�� Select the Close button to return to the Submit to USPTO screen after selecting 

the desired certificate. 
 
Upon returning to the Submit to USPTO screen, the Send button will be available. 
 

�� Select the Send button to file the submission to the USPTO server.  Either the low 
level PKI certificate or the high level PKI certificate will establish a secure 
contact session with the USPTO to transmit the patent application. 

 
�� Select the Back button to return to the Validate the Project screen.  Select the 

Help button for information about the screen.     
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Sending a package to the USPTO 
 
During the submission process, submission status windows are displayed.  (Examples 
appear below.)   
 
The first status window indicates the progress of the submission, the stage the submission 
has reached, and any messages from the USPTO server.      
 

 
Submission Status message 

When submission is complete, another status window indicates that the submission was 
successfully uploaded to the USPTO.    
 

 
Submission Status message 

 
�� Select the Suspend button on the status window to pause the submission process.  

Select the Cancel button to end the submission process.   
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Obtain Acknowledgment Receipt Screen 
 
When the submission is complete, the USPTO server will return an acknowledgement 
receipt.   
A dialogue box will be displayed indicating that the Acknowledgement Receipt is ready 
to be viewed.   
 

 
Acknowledgement Receipt notification 

�� Select the OK button to view the acknowledgement receipt. 
 
 

 
Acknowledgment receipt: top half 
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Acknowledgment receipt: bottom half 

 
 

�� Print the acknowledgement receipt by selecting Print from the File menu, by 
selecting the Print icon on the toolbar, or by using the keyboard shortcut Ctrl + P.   

 
After the package has been transmitted successfully, the USPTO server dates and 
timestamps the package and uses digital signature technology to verify that the contents 
of the package have not been altered during transit.   
 
The USPTO server also returns certain information to ePAVE that ePAVE then uses to 
create the acknowledgement receipt.  The acknowledgement receipt will include the 
application number, confirmation number, a unique EFS transaction ID and the date and 
time when the USPTO received the submission. 
 
The acknowledgment receipt is returned in real time.  It is automatically saved in the 
same folder as the rest of the submission.  The acknowledgment receipt should be 
printed. 
 

More information about the acknowledgment receipt is available at the EFS Legal Framework, 
located at the patent Electronic Business Center web site, USPTO.gov/ebc.  
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Acknowledgement Receipt 

The Acknowledgement Receipt contains the following information. 
 

Title of Invention – This field displays the title of the invention contained in this 
submission. 

 
Submission type - This field shows the type of submission that was received by the 

USPTO. 
 
Application Number - This field shows the application number associated with this 

submission. 
 
EFS ID – This field shows the ID of the EFS server for this submission.  
 
Server Response – These fields display messages being sent from the USPTO EFS 

server.  These messages indicate whether the submission was successful and provide 
warnings or errors detected by the EFS server.   

 
ICON1 – This is the USPTO assigned confirmation number.    

 
First Named Applicant - This field shows the name of the first named inventor entered 

in the Add Common Data Elements screen. 
 
Attorney Docket Number – This field shows the attorney docket number entered on the 

Add Common Data Elements screen. 
 
Timestamp – This field shows the date and time that the submission was received at the 

USPTO.   
 
From – This field shows that this submission was for U.S. practice.   
 
File Listing - This field shows an itemized listing of all files that were included in the 

submission package that was sent to the USPTO.  It includes the file size, date produced, 
and the total submission size. 

 
Message Digest –This field shows a message that is unique to this submission.  This 

digest serves as proof of what was submitted should any question arise in the future.   
 
Digital Certificate Holder Name – This field shows the name of the digital certificate 

that was used to establish the secure connection with the USPTO server. 
 
 

Exiting ePAVE or Preparing Another Submission 
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�� Exit ePAVE by selecting Exit from the File menu or by selecting the X icon in 
the upper right-hand corner of the screen. 

 
�� Begin a new submission by selecting New from the File menu, by selecting the 

New icon from the toolbar, or by using the keyboard shortcut Ctrl+N. 
 

�� Open another submission under construction by selecting Open from the File 
menu, by selecting the Open icon from the toolbar, or by using the keyboard 
shortcut Ctrl+O.   
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